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About

You can share this PDF with anyone you feel could benefit from it, downloaded the latest version 
from: watchkit

It is an unofficial and free watchkit ebook created for educational purposes. All the content is 
extracted from Stack Overflow Documentation, which is written by many hardworking individuals at 
Stack Overflow. It is neither affiliated with Stack Overflow nor official watchkit.

The content is released under Creative Commons BY-SA, and the list of contributors to each 
chapter are provided in the credits section at the end of this book. Images may be copyright of 
their respective owners unless otherwise specified. All trademarks and registered trademarks are 
the property of their respective company owners.

Use the content presented in this book at your own risk; it is not guaranteed to be correct nor 
accurate, please send your feedback and corrections to info@zzzprojects.com
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Chapter 1: Getting started with watchkit

Remarks

Apple Documentation on WatchKit (through API Reference): 
https://developer.apple.com/reference/watchkit

•

Getting familiar with Xcode: Xcode Interface•

Examples

Creating a new watchOS project

To develop an application for watchOS, you should start with Xcode. Xcode only runs on macOS. 
At the time of writing, the latest version is Xcode 8.3.

If you want to start a new project from scratch:

Boot up your Mac and install Xcode from the App Store if it's not already installed.1. 

Choose to create a new project.2. 

In templates, choose watchOS and then "iOS App with WatchKit App".3. 
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Fill your project details and choose a location.4. 

If you already have an iOS project and want to add a watchOS target:

Go to File -> New -> Target.1. 

Choose WatchKit App.2. 

Fill your target details and choose a location.3. 

Making a simple "Hello, World!" app

Each watchOS target includes an App and an Extension. App contains the UI stuff and Extension 

Each WatchKit App has a Interface.storyboard file which you design the app in it, and a 
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Assets.xcassets file to put your assets in.

Each WatchKit Extension has a InterfaceController.swift file (actually a WKInterfaceController 
subclass) which is similar to the ViewController file in iOS.

To make a Hello World app:

Open up the Interface.storyboard.1. 

Locate the main InterfaceController.2. 

From the library in the right pane, add a WKInterfaceLabel.3. 

Drag the label and set its text in the right pane to "Hello, World!".4. 
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Select the correct scheme (according to the next picture), then run the project by either 
tapping the run button in the top bar, using Product menu, pressing Cmd-R or tapping run in 
the Touch Bar.

5. 
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Apple Watch simulator will eventually show up with your app running.

Connecting the code with the UI

Like iOS where you use @IBOutlet and @IBAction, here you could use them too.

Let's say we have a button which when clicked changes the label's text to something else.

To get started:

Add a WKInterfaceLabel and a WKInterfaceLabel to the InterfaceController.1. 
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Ctrl-Drag from the WKInterfaceLabel to InterfaceController.swift and enter the details as 
shown in the following picture to add an outlet property:

2. 

Ctrl-Drag from the WKInterfaceButton to InterfaceController.swift and enter the details as 
shown in the following picture to add an action method:

3. 

Fill the action method:5. 

Swift

outputLabel.setText("Button Tapped!")

Objective-C

[[self outputLabel] setText:@"Button Tapped!"]

Run the program and tap the button to see the result.6. 

Read Getting started with watchkit online: https://riptutorial.com/watchkit/topic/9568/getting-
started-with-watchkit
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Chapter 2: Navigation

Remarks

Important Note

Apple has highly discouraged use of both navigation styles in one controller, and this 
may result in an app rejection.

Currently, the preferred way is to use hierarchical style rather than page based, as used in many 
more Apple apps than before.

Examples

Page-based navigation

Many watchOS apps (like Activity) have several pages which you could simply scroll between 
them, which is a very good way to use Apple Watch.

To create a page based navigation, Ctrl-Drag from one controller to another, and select "next 
page", as shown in the following picture:
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Hierarchical view structure

Many watchOS apps (like Workout, Weather, Music, etc) have a main WKInterfaceTable or a set of 
buttons which are hooked up to another controller, similar to the navigation on iOS. This is called 
hierarchical view structure.

To connect a button, Ctrl-Drag from the button to a controller, and select "push" or "modal" based 
on your need, as shown in the following picture:
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Read Navigation online: https://riptutorial.com/watchkit/topic/9599/navigation
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Chapter 3: WatchConnectivity

Introduction

Connecting your WatchOS application to your iOS application can be a task to complete when you 
have never done it before. This tutorial will show you the basic fundamentals in order to 
accomplish this very important task.

Examples

iOS Configuration

iPhone App

import WatchConnectivity and conform to WCSessionDelegate.1. 
use the static session delegate via WCSession.default().2. 
Send data to Watch app using:3. 

 WCSession.default().sendMessage(message, replyHandler:_ errorHandler:_)

The message object should be a dictionary of type [String:Any]4. 
If you are looking for data to be returned from the Watch app, provide the logic in 
a closure defined in the replyHandler; otherwise, pass in nil.

5. 

To respond to messages sent from the Watch app, you will use the 
WCSessionDelegate callback method

6. 

func session(_ session: WCSession, didReceiveMessage message: [String : Any], 
replyHandler: @escaping ([String : Any]) -> Swift.Void){...}

You need to import the WatchConnectivity framework into your view controller file in the iOS 
application. This gives you access to the class objects that are designed to communicate with the 
Watch companion application. You will need to import this on the Watch app side as well. The only 
real difference with the Watch app is that you will not have a view controller file, but an interface 
controller file.

import WatchConnectivity

Next, you will need to make sure that your application can support a session for 
WatchConnectivity. If it can, then you must set the view controller as its delegate and activate the 
default session. You will get an error here. You need to conform to WCSessionDelegate and 
implement a few methods before the IDE begins to calm down.

// MARK: - View Life Cycle Callbacks 
override func viewDidLoad() { 
    super.viewDidLoad() 
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    automaticallyAdjustsScrollViewInsets = false 
    if WCSession.isSupported() { 
        WCSession.default().delegate = self 
        WCSession.default().activate() 
    } 
    else { 
        print("\nViewController: connectionManager is nil\n") 
    } 
}

To conform to WCSessionDelegate, let's add an extension to the bottom of the view controller. 
Some people hate this approach. I have my way, but for tutorial purposes, I will follow the 
RayWenderlich approach. I am a huge fan of just getting code directly from COMMAND + 
CLICKING on the delegates and grabbing ALL OF THE METHODS out of the specification and 
begin to manipulate it and understand how things work. In this extension, I am providing you will 
all of the methods. They are already marked so that you will see when each of them fire in the 
console. If you feel frisky, delete some of the ones that are marked OPTIONAL to make your code 
file look spiffy.

extension ViewController : WCSessionDelegate { 
 
    func session(_ session: WCSession, activationDidCompleteWith activationState: 
WCSessionActivationState, error: Error?) { 
        print("0. ViewController: ", "activationDidCompleteWith activationState") 
    } 
 
 
    /** ------------------------- iOS App State For Watch ------------------------ */ 
 
    func sessionDidBecomeInactive(_ session: WCSession) { 
        print("1. ViewController: ", "sessionDidBecomeInactive") 
    } 
 
 
    func sessionDidDeactivate(_ session: WCSession) { 
        print("2. ViewController: ", "sessionDidDeactivate") 
    } 
 
 
    func sessionWatchStateDidChange(_ session: WCSession) { 
        print("3. ViewController: ", "sessionDidDeactivate") 
    } 
 
 
    /** ------------------------- Interactive Messaging ------------------------- */ 
 
    func sessionReachabilityDidChange(_ session: WCSession) { 
        print("4. ViewController: ", "sessionReachabilityDidChange") 
    } 
 
 
    func session(_ session: WCSession, didReceiveMessage message: [String : Any]) { 
        print("5. ViewController: ", "didReceiveMessage") 
    } 
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    func session(_ session: WCSession, didReceiveMessage message: [String : Any], 
replyHandler: @escaping ([String : Any]) -> Swift.Void) { 
        print("6. ViewController: ", "didReceiveMessage") 
        // This is where you handle any requests coming from your Watch App 
    } 
 
    func session(_ session: WCSession, didReceiveMessageData messageData: Data) { 
        print("7. ViewController: ", "didReceiveMessageData") 
    } 
 
    func session(_ session: WCSession, didReceiveMessageData messageData: Data, replyHandler: 
@escaping (Data) -> Swift.Void) { 
        print("8. ViewController: ", "didReceiveMessageData") 
    } 
 
    /** -------------------------- Background Transfers ------------------------- */ 
 
    func session(_ session: WCSession, didReceiveApplicationContext applicationContext: 
[String : Any]) { 
        print("9. ViewController: ", "didReceiveApplicationContext") 
    } 
 
    func session(_ session: WCSession, didFinish userInfoTransfer: WCSessionUserInfoTransfer, 
error: Error?) { 
        print("10. ViewController: ", "didFinish userInfoTransfer") 
    } 
 
    func session(_ session: WCSession, didReceiveUserInfo userInfo: [String : Any] = [:]) { 
        print("11. ViewController: ", "didReceiveUserInfo") 
    } 
 
    func session(_ session: WCSession, didFinish fileTransfer: WCSessionFileTransfer, error: 
Error?) { 
        print("12. ViewController: ", "didFinish fileTransfer") 
    } 
 
    func session(_ session: WCSession, didReceive file: WCSessionFile) { 
        print("13. ViewController: ", "didReceive file") 
    } 
}

To send data to your Watch App, once the Watch App has requested it, you will handle this in the 
method...

func session(_ session: WCSession, didReceiveMessage message: [String : Any], replyHandler: 
@escaping ([String : Any]) -> Swift.Void) { 
    print("6. ViewController: ", "didReceiveMessage") 
    // build out your response message using a Dictionary 
    let returnMessage: [String : Any] = [ 
       "key1" : value1, 
       "key2" : value2, 
       "key3" : value3 
    ] 
    // return your data in this manner 
    replyHandler(returnMessage) 
    // WARNING 
    // You must call the replyHandler before the method ends, otherwise, your app will crash. 
}
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This is only one half of the transaction! You must configure your Watch app to connect to the 
iPhone app and handle any returned messages!

Watch Extension Configuration

WatchKit App

import WatchConnectivity and conform to WCSessionDelegate.1. 
use the static session delegate via WCSession.default().2. 
Send data to the iPhone app using:3. 

 WCSession.default().sendMessage(message, replyHandler:_ errorHandler:_)

The message object should be a dictionary of type [String:Any]4. 
If you are looking for data to be returned from the Watch app, provide the logic in 
a closure defined in the replyHandler; otherwise, pass in nil.

5. 

To respond to messages sent from the iPhone app, you will use the 
WCSessionDelegate callback method

6. 

func session(_ session: WCSession, didReceiveMessage message: [String : Any], 
replyHandler: @escaping ([String : Any]) -> Swift.Void){...}

These methods will not be required in your Watch app to properly conform to the 
WCSessionDelegate:

7. 

 func sessionDidBecomeInactive(_ session: WCSession) 
 func sessionDidDeactivate(_ session: WCSession) 
 func sessionWatchStateDidChange(_ session: WCSession)

And finally, it is generally best practice to store any common images, the images and assets that 
will continually be used for the Watch app to be placed in the Watch's xcassets folder. Okay, now 
that you are confused, let's get to the details!

It might be a surprise to you, but you need to import WatchConnectivity again.

import WatchConnectivity

Next, you need to verify that the session is even possible.

// MARK: - View Life Cycle Callbacks 
override func awake(withContext context: Any?) { 
    super.awake(withContext: context) 
 
    // Configure interface objects here. 
    if WCSession.isSupported() { 
        WCSession.default().delegate = self 
        WCSession.default().activate() 
        print("InterfaceController: Session Activated") 
 
        // Request Data from iPhone App 
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        let requestMessage = ["message":"get-data"] 
 
        WCSession.default().sendMessage(requestMessage, replyHandler: { (replyMessage) in 
            print("Got a reply from the phone: \(replyMessage)") 
 
            // handle reply message here 
 
        }, errorHandler: { (error) in 
            print("Got an error sending to the phone: \(error)") 
        }) 
    } 
    else { 
        print("\nViewController: connectionManager is nil\n") 
    } 
}

But none of this will work, unless you implement methods required for the WCSessionDelegate.

extension InterfaceController : WCSessionDelegate { 
 
    func session(_ session: WCSession, activationDidCompleteWith activationState: 
WCSessionActivationState, error: Error?) { 
        print("1. InterfaceController: ", "activationDidCompleteWith activationState") // 
first 
    } 
 
    /** ------------------------- Interactive Messaging ------------------------- */ 
 
    func sessionReachabilityDidChange(_ session: WCSession) { 
        print("2. InterfaceController: ", "sessionReachabilityDidChange") // second 
    } 
 
    func session(_ session: WCSession, didReceiveMessage message: [String : Any]) { 
        print("3. InterfaceController: ", "didReceiveMessage") 
    } 
 
    func session(_ session: WCSession, didReceiveMessage message: [String : Any], 
replyHandler: @escaping ([String : Any]) -> Swift.Void) { // third 
        print("4. InterfaceController: ", "didReceiveMessage") 
        //print("Message Contents: ", message["message"]!) 
    } 
 
    func session(_ session: WCSession, didReceiveMessageData messageData: Data) { 
        print("5. InterfaceController: ", "didReceiveMessageData") 
    } 
 
    func session(_ session: WCSession, didReceiveMessageData messageData: Data, replyHandler: 
@escaping (Data) -> Swift.Void) { 
        print("6. InterfaceController: ", "didReceiveMessageData") 
    } 
 
    /** -------------------------- Background Transfers ------------------------- */ 
 
    func session(_ session: WCSession, didReceiveApplicationContext applicationContext: 
[String : Any]) { 
        print("7. InterfaceController: ", "didReceiveApplicationContext") 
    } 
 
    func session(_ session: WCSession, didFinish userInfoTransfer: WCSessionUserInfoTransfer, 
error: Error?) { 
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        print("8. InterfaceController: ", "didFinish userInfoTransfer") 
    } 
 
    func session(_ session: WCSession, didReceiveUserInfo userInfo: [String : Any] = [:]) { 
        print("9. InterfaceController: ", "didReceiveUserInfo") 
    } 
 
    func session(_ session: WCSession, didFinish fileTransfer: WCSessionFileTransfer, error: 
Error?) { 
        print("10. InterfaceController: ", "didFinish fileTransfer") 
    } 
 
    func session(_ session: WCSession, didReceive file: WCSessionFile) { 
        print("11. InterfaceController: ", "didReceive file") 
    } 
}

Sending Data

Sending data to your Watch app from your iPhone or from your iPhone to your Watch App after 
triggering some event is very simple, though the code can look a little complex at first.

let message = ["key":"value-to-send"] 
 
WCSession.default().sendMessage(message, replyHandler: { (replyMessage) in 
    print("Got a reply from the phone: \(replyMessage)") 
 
    if let returnedValues = replyMessage["returned-value"] as? NSArray { 
        for val in returnedValues { 
            // do something here with the data 
            // Dispatch to Main Thread if affecting UI 
        } 
    } 
}, errorHandler: { (error) in 
    print("Got an error sending to the phone: \(error)") 
})

Read WatchConnectivity online: https://riptutorial.com/watchkit/topic/10733/watchconnectivity
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